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	Note:  If you would like custom profiling services from CHROMiX, please the ColorValet section of the www.chromix.com website.



www.chromix.com/colorvalet

CHROMiX now offers a program (ColorValet Client) which walks you through the steps of printing out a profiling target and sending it in to have a profile made.  This Client program is intended to make the whole process easier for the user.


	This page contains instructions that CHROMiX offered its customers before the Client program was available.  While it is somewhat superseded by the ColorValet Client, it is offered here because many people still find the material informative and useful. 



Last updated: June, 2010.
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 Introduction

Welcome to the CHROMiX ColorValet Kit. Now you can easily have custom profiles built for your printer! Custom profiles take into consideration your paper, inks, driver settings, and more to get you the most accurate color possible. Find out how accurate and powerful color management can be.

We have made profiling your printer as painless as possible and are constantly striving to streamline the process. If you have any suggestions regarding simplifying or clarifying the document you are about to read or the profiling process in general, please do not hesitate to let us know.

The procedure is fairly simple. You print out the targets, mail them in, and we build you a profile. Please follow the instructions carefully to ensure we are able to build you the best profile possible.





 Frequently Asked Questions

What is a profile?

An ICC profile is a file that describes a color device’s capabilities and limitations. It can be used in conjunction with Apple’s ColorSync or Windows’ ICM technology and applications like Adobe Photoshop to correct color images, match colors as closely as possible from scanner to monitor to printer, and also simulate the appearance of images on another device like a press. 

What is the price?

One print profile is $99 (US). If you have other services you want performed or additional sampling through a larger target, please contact us for pricing. These prices are as of March, 2009 and are subject to change without notice. Please refer to our website at www.chromix.com for current pricing.

Why custom profiles?

Each and every color device creates color differently. Even two printers of the same model and make will require slightly different settings to produce the same color (and will produce slightly different colors with the same settings). Also, the paper used for printing has a great effect on the appearance of images and different paper weights and colors will change colors in printed images.

Custom profiles take many different factors into account including paper color, texture (especially how it may affect liquid inks), printer settings and more. The only way to ensure you are receiving the most accurate image fidelity possible is to use a profile that was created especially for your device, paper, inks and settings. For more details about what printer profiles take into account, see Appendix A.



What is this profiling service?

CHROMiX offers a custom profiling service to help color image creators get the most accurate color possible from their devices. High-quality profiles require measurements using spectrophotometers and calculations using the best software. ColorValet profiles give you very high quality results without the investment in equipment, training, and time.

How do I use my profiles?

Profiles are very versatile and can be used in several different ways. They can be used to match colors so the image you scanned looks right on your monitor and prints correctly. Profiles from presses and other output devices can be used on a designer’s system to simulate the appearance of an image either on the monitor or on a printer. In some cases profiles can also be used to correct color problems in images. Profiles are used anytime an image is transformed from one format to another. So when you separate an RGB file to CMYK in Photoshop, an RGB source profile and a CMYK destination profile are used to calculate the separation.

We will supply basic instructions with your completed profile on how to setup Adobe Photoshop and use profiles for matching and simulation. Any other use of profiles is outside the scope of this service and we suggest you obtain additional training and consulting to ensure you are getting maximum benefits of ICC color management. CHROMiX can help in each of these areas. Please call us at 866-CHROMiX (206-985-6837), email help(at)chromix.com, or visit our website at www.chromix.com for more information regarding our products and services.

How many printer profiles do I need?

If you always use the same inks and the exact same paper, you may only require one profile. But each time you use different inks or paper, you should use a different profile. Remember that profiles are intended to “characterize” a printing process. If you change any part of that process and it has an effect on the colors produced, you need a different profile. See Appendix A for more information.

How long is my profile valid? When do I need another profile made?

Your profile will remain valid until something occurs that changes the way your printer produces color. Changing the paper you use, getting a print head replacement, or buying your inks from a different manufacturer are all things that could invalidate your profile and require a new one to be made.

How do I get profiles for my monitor and scanner?

For best results your monitor should be calibrated and profiled using a colorimeter (small device which reads colors directly from your CRT or LCD display). Colorimeter prices have fallen dramatically and are now quite affordable. At ColorGear.com, our online store, we also bundle colorimeters with ColorValet print profiles for additional savings. At the very least, you should use the “by-eye” calibration available on most systems. Apple’s ColorSync 2.5 and later and Adobe Photoshop (Mac and Windows) both include a visual calibrator that steps you through the process of visually calibrating and profiling your monitor.

A scanner profile is also relatively easy to create and because scanners don’t drift much, they may be the easiest devices in your workflow to maintain. Some scanners include software and test patterns to create profiles. CHROMiX sells and supports scanner profile creation software and targets. Please feel free to email or call us if you have any questions regarding scanner profiles.

What if I want to make my own printer profiles?

Making profiles requires attention to all the details outlined in this document and more. If you are interested in producing your own profiles, please give us a call. We sell and train on several different brands of profile making software and hardware and would be happy to help you move this valuable process in house.

What guarantee or warranty comes with my custom profile?

At CHROMiX we guarantee our print profiles 100%. If you do not like the profile, you do not pay.

The CHROMiX ColorValet Print profiling service is intended as a low-cost alternative to buying color management hardware and software or having a color professional come onsite to your location to build a profile. It is not intended as a substitution for color management training, workflow consulting, environmental consulting, or trouble-shooting. We suggest that to take full advantage of the capabilities color management offers, that you hire a color management professional or firm (like CHROMiX) to help you through what can be a complicated process. Due to the fact that we have no control over your environment or the processes you use to produce the color targets necessary for the profiling process, or the processes you use to produce your final images, we limit our guarantee and liability to the price of the profile. We cannot be held responsible for problems, losses, etc occurring as a result of the use of a profile that we have created. That said, we will do our best to correct a profile for you to ensure it fits your equipment and workflow as closely as possible. Again, if you have any questions regarding this service, please contact us. We’re happy to answer any questions you may have.

I use Windows – can I still use ICC profiles?

All ICC profiles, if built properly, can be used on Mac or Windows computers. Your ability to use them depends more on your applications that the operating system. Most Corel and Adobe products correctly use profiles on both computing platforms. For others we suggest you consult your manuals and the manufacturer. Also, ensure you test your application’s use of profiles carefully. Not all applications use profiles correctly.


	Building Your Custom Profile:



 Here is an overview of the steps that you will follow:

A. Determine your printer type

B. Open the correct target in Photoshop or other program

C. Print the target

D. Inspect the target 

E. Print and fill out the order form

F. Send it all to CHROMiX

G. We will email your custom profile to you

H. Install the profile on your computer

Building a custom profile for your device is a relatively straightforward process but requires several steps that need to be followed carefully. Please read all the following instructions once and then follow them thoroughly.


 A. Determine your printer type

Explanation

When you print documents, your computer takes the information from your program and translates it into instructions for the printer to follow when applying colorants to paper. Some printer drivers expect CMYK data and pass that data onto the printer with minimal modification, other printer drivers expect RGB data and then internally convert the RGB data to CMYK for printing. For most purposes, knowing this information is not too important and the process is invisible to the user but when trying to characterize a device (build a profile), understanding this process is essential.

“Rules of Thumb”

If you are printing to an inkjet printer using the manufacturer’s included drivers you should use the RGB target. This includes Epson, Canon, HP, Lexmark and other printers. It does not matter if the printer itself uses CMYK, CcMmYK or other ink sets. Control of the printer is limited to RGB and so it is the best method for profiling.

If you are printing to any printing system through a RIP – this includes inkjet, laser, copier, and so forth – you should probably use the CMYK target. You can also profile many RIP systems using RGB targets but this choice is beyond the scope of this document. Please contact us with questions related to RGB profiling of CMYK or other multi-color RIPs.

If you are not sure, print the “CMYK vs RGB test.tif” file.


 Procedure

	 Locate the file “CMYK vs RGB test.tif” and open it in Photoshop or your image editing program.

	 Print it out using the same print procedures for printing the target described on page 8.

	 Carefully inspect the print.




 

The file consists of a CMYK document with a gray ramp in the K (black) channel. If the printing system is a true CMYK system (and is not performing any simulation), the gray ramp should print with black ink ONLY. If the gray ramp contains CMY inks (look through a loupe), then you should probably use the RGB target.

When in doubt print and send all three targets then we can determine which one is appropriate. Just make sure you let us know what the targets are for.

Geek Speak (totally optional reading)

When an application prints CMYK data to an “RGB native” printer driver, it first converts the data to RGB, and then the driver converts it back to the CMYK or CMY required by the printer. This requirement is actually imposed by the operating system (Mac or Windows). We can test for this process by sending a gray ramp where only the K (black) channel contains any information. If the printer driver is RGB native, the application will convert the grays to RGB data. When the driver performs the second conversion to CMYK, it will typically build the grays using all 4 ink colors to help with blending and avoid creating dark black spots in the lighter colors. This is obviously NOT the same information that was originally sent to the printer. If the printer was CMYK native, the data would pass straight through (in most cases) and the gray ramp would be printed with black ink only. Even this test can give unclear results sometimes. See “When in doubt” above.


  B.  Open the correct target in Photoshop or other program

	 First ensure that your “Color Management Policies” in Color Settings (Edit, Color Settings) are set to “Off” or “Preserve Embedded Profiles” for your file type (RGB or CMYK).

	 Open the correct profile target you received for your printer in Photoshop or other image-editing program. This will be either the 
	 “CX RGBx1 Profile Target.tif” or the 

	  “CX CMYKx1V2 Profile Target.tif”.




	 Select “Leave as is” (Don’t color manage) when Photoshop prompts you.



 C.  Print the target

When printing a profiling target it is essential that your program, printer driver, and printer be set up the same way you will print your normal images and do not perform any automatic color correction or color management. In this profiling process we are attempting to determine the uncorrected color capabilities and limitations of your printer. Then you will use the resulting profile to correct for, and take advantage of, your printer’s capabilities.





 If you are printing from CS5

Adobe has eliminated the option for “no color management” in the Print dialog window of Photoshop CS5.  Therefore, in order to print a profiling target without color management the following workaround is required:


		Assign the AdobeRGB profile to the target image.  (Choose Edit > Assign Profile and choose Adobe RGB.)

		Select File > Print 

		Choose “Color Management” from the popup menu on the upper right.

		Choose the “Document” radio button

		For color handling, choose “Photoshop Manages colors”

		For Printer Profile, choose the AdobeRGB profile (the same profile you used in step #1.) 

		Printer Driver Setup
		Windows: Click Page Setup…   to open up the print driver’s properties window.  You will have to turn off color management in  your printer driver, if this has not been done already.  Usually there is a setting called “No Color Adjustment,” or “ICM” and as printer drivers are different, it can take some hunting around to find it.  If you cannot find the setting on your own, consult your printer’s user manual. Once you have turned off color management in the printer driver, click “Okay” to exit the page setup dialog, and click “Print” in the Photoshop Print dialog.

		Mac OS X: Click the Print button, which will open up the standard print driver window. Open up the drop-down box under “Copies and Pages” and choose “Print Settings.” In the “Basic” tab, choose the settings you will normally use when printing.  For “Color Settings,” choose Off (No Color Adjustment).  Click the Print button to print the target.










[image: PSnoCM.jpg]

 If you are printing from CS3 or CS4

	 Select File > Print  

	 Choose “Color Management” from the popup menu on the upper right. 

	 Choose the “Document” radio button 

	 For color handling, choose “No Color Management” 

	 Click Print..., and proceed to Printer Driver (see illustration) 










 If you are printing from CS2

	 Select File:Print with Preview…

	 In the Print Preview dialog, check the “More Options” button.  Then choose “Color Management” from the popup menu.

	 In the Print field, click on “Document”.

	 In the Options field, choose “No Color Management.”

	 Click Print, and proceed to Printer Driver…





7. (Printer driver)  At this point, you have you have turned off Photoshop’s color management, and you are now seeing the dialog for the printer driver.  You will need to turn color management off here as well.  


	 Navigate into the “Custom” or “Advanced” section of the driver and turn all color management off. This may be labeled as “No Color Adjustment.” We do not suggest using “Automatic “ or other correction settings as we have found they can drastically affect the gamut of the printer. If you can, save these settings as “Profiled <paper type>” so they are easy to recall later.

	 Print.







 If you are printing from Photoshop 7 or CS

	 Select File:Print with Preview…

	 In the Print Preview dialog, check the “Show more Options” check box.   

	 Choose “Color Management” from the popup menu just beneath.

	 Set Source Space to “Document”

	 Set Print Space to “Same as Source”

	 Click Print, and proceed to Printer Driver

	 (Printer driver)  At this point, you have you have turned off Photoshop’s color management, and you are now seeing the dialog for the printer driver.  You will need to turn color management off here as well.  
	 Navigate into the “Custom” or “Advanced” section of the driver and turn all color management off. This may be labeled as “No Color Adjustment.” We do not suggest using “Automatic “ or other correction settings as we have found they can drastically affect the gamut of the printer. If you can, save these settings as “Profiled <paper type>” so they are easy to recall later.

	 Print.










 Notes:

	 If you use different paper stocks or ink sets, you should realize that a new profile may need to be built for each paper or ink used. The profile target should be printed on each type of paper or with each type of ink used. (and every combination thereof). Each variation will result in a separate profile that you will use when printing with that setup. Please refer to “Appendix A – Ingredients of a Printer Profile” for more information regarding which settings and environmental changes influence printing and may require a new profile to be generated.

	 The target will appear “sideways’ when you open it in Photoshop.  We need it to fit to a letter size sheet (8.5 in x 11 in), so print this “sideways” target in portrait mode.  The final printed target should have its printed words along the long edge of the paper.

	 Please do not alter or resize the profile target it any way. It is designed to be read by an automated spectrophotometer and any changes could break this process. You would then be required to print another target and mail it in again!  Call us at 866.247.6649 if you need a differently-sized target.

	 If you are using a print system that prints dot-for-dot (such as the Fujix Pictrography), then you may need to “upsample” the file. Determine the printing resolution and then change the resolution of the file in Photoshop’s “Image:Image Size…” dialog. Simply enter your printing resolution and select “Nearest Neighbor” as the “resample” method. This maintains clean patches and should create the correct size target.

	 If you are printing from another imaging application, refer to the documentation for your software to determine how to disable or bypass any color correction that may be taking place.



-	-	-	-	-	-	-	-	-	-


	 For RGB-based printer drivers you can affect ink levels and tonal smoothness by selecting different media settings.  These are labeled with names such as ”Glossy Photo Paper,” “Premium Lustre paper,” and so on. (Note: These are media settings, and not profiles.  Using them does not apply color management). We recommend initially trying the settings recommended by the manufacturer or paper/ink vendor. Backlit film and other settings may also give good results. Look for fully saturated colors and dark blacks while still showing smooth tones from paper white all the way through to black. If you note sharp transitions where highlight or shadow colors are lost, experiment with different settings.

	 If you are using a RIP or other device that allows calibration (check your documentation to see if your device can be calibrated), ensure that it has been calibrated using a standard procedure immediately before printing the profile targets. For color laser copiers and many other output devices, regular and correct calibration is essential to creating accurate profiles that remain valid over time.

	 To ensure the best results, TAKE NOTES! Enough time may pass between printing the profile target, and your profile-corrected images that you could forget the settings you used originally. Consistency is one of the most important aspects of managing your color and that includes using the same procedures and settings each time you print.



 D. Inspect the target

1. Carefully inspect the printout and ensure there are no blotches, spots, or any other problems on any of the color patches.


	 If you notice streaking or splotches on any of the target patches, try running your printer’s head cleaning and head alignment procedures (nozzle check).  Consult your printer’s documentation for instructions on doing this.  It is very important that the target has no blemishes or splotches.  If it does, we may need to ask you to print and send a new target, which may inconvenience you.

	 Do not write notes or attach anything to the back of the printed target.  This may affect the reading taken by our spectrophotometer.

	 Remember to leave margins around the target.  We need some white space to attach the target to the spectrophotometer’s table.



 E. Print and fill out the order form

	 Fill out the “Custom Profile Order Form” as completely as you can.

	 Attach the form to the target – please do not staple them! Paper clips work fine.



 F. Send it to CHROMiX at the following address:

CHROMiX ColorValet Service
8320 5th Ave NE, #B
Seattle, WA  98115
USA


 G. We will email the custom profile to you.

We will build you a profile and send it to you via email or web (your choice).   Our turnaround time is generally 24 to 48 hours.

If you have any questions or concerns about this service, please feel free to email us (help(at)chromix.com) or call us at (206)-985-6837 
or 866-CHROMiX.


 Appendix A – Printer Profile Ingredients

An ICC printer profile contains an amazing amount of information. When your printer is characterized in the profiling process, all of the aspects of the printing process are taken into consideration. We have produced the following list as an illustration of some of the things captured by a printer profile. You should also note that if any one of these “ingredients” changes, your profile may become invalid and the device may need to be recalibrated or a new profile created.


 Information “Contained” within an ICC Profile

	 Dot Gain

	 Registration

	 Inks

	 Stock

	 Temperature

	 Humidity

	 UCR (Under color removal)

	 GCR (Grey component replacement)

	 Screening

	 Resolution

	 Driver Settings

	 Application Settings

	 OS Settings

	 Calibration

	 PPD, PDF file settings



The following items, while not captured in most profiles, can also affect color output:


	 Application-specific ICC/ColorSync implementation

	 Film / Paper aging

	 Fuser Aging

	 Power Supply anomalies

	 Operator error, changes
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